
 Remote Sensing, Fall 2020: Lab 9 (or is that 8 ?) 
 

DIGITAL ELEVATION MODELS 
 

 

In this lab, we will use non-spectral ‘ancillary’ DEM data. Most of the tasks below could also be 

completed using GIS software . 

 

A. PG - Preparing the DEM from TRIM files 

 

Start Geomatica Focus Banff and open your PG 1996 pix file (you could use your 2013 image 

file – either way no problem, and display the optimal colour composite. 

To confirm the size of the Landsat (TM) pixels, switch the maps tab to files, right-click on the 

pix filename and select properties -> projection …  this will give you the pixel size. 

 

I've pre-prepared a DEM to match from the BC TRIM  

- we are going to transfer the DEM as a new layer (channel) into your image .pix file.  

 

Layer-> add-> grayscale  and browse to  find  /home/labs/GEOG357/pgdem.tif 

 

Open/Display the new TIF file and ensure it matches the Landsat in extent 

Right-click on the new DEM .tif and -> overview of layer 

 

What is the pixel size: switch to files tab, right-click -> properties and view the last tab 

It’s part of the BC TRIM provincial DEM created at a different resolution to today’s imagery 

 

You can view it this way, but to include it in analysis with your imagery, you need to  

transfer the DEM layer into your PIX file 

 

File -> Utility -> Transfer  (NOT translate or you will destroy your output data file) 

source :  pgdem.tif 

destination: your PG 1996 .pix file 

select all-> add->transfer layers 

Close 

 

Check it is there: switch from maps to files tab 

Expand the rasters list -> the DEM should be the bottom layer 

Rename it properly - right-click -> properties and type its name as the label e.g. DEM 

Note that it is 16bit signed, whereas the TM image layers are 8-bit unsigned 

switch tab back to maps from files 

 

Note: all channels must be in the same pix file for analysis and display 

 



1. Viewing your DEM  
 

Add the new channel as grayscale:   

layer -> add -> grayscale -> pick the pg1996 file -> DEM channel -> Finish 

 

zoom in so you can see individual pixels and compare them with the Landsat (switch the DEM 

layer on/off) ... transferring the DEM has converted pixel resolution from 25 to 30m to match 

 

.. click the mouse on a few locations and note the elevations in metres, and view all values in 

layers-> histogram and the cursor panel, what are the minimum and maximum values ?  

 

What do you make of the histogram peaks – knowing the local area geomorphology ? 

They will be more common values - where it is flatter e.g. water or plateau surfaces e.g. the River, Lake, Bowl 

 

Q1. What is the elevation of  a. Shane Lake   b. Tabor Lake   ? 

 

All tasks below are found in Algorithm Library -> Analysis -> DEM Analysis    

Resulting output image layers may be to the viewer- grayscale (unless we need to keep them, and 

then we’d also write to your PIX file 

In all cases, you are inputting the DEM channel as this is the mother layer for other layers 

 

2. Shaded Relief  ( REL )  
 

Output Ports: Select Viewer-Grayscale (will display in Focus) 

INPUT PARAMS TAB 

Pixel X Size: 30 

Pixel Y Size: 30 

Elevation Step Size: 1   (= the ‘step’ between adjacent integer values) 

Azimuth  Angle of Light Source: 315  - note that its not the default like in GIS software 

Elevation Angle of Light Source: 45 

Select LOG tab and run  

 

Look at the shaded relief as a grey-scale image (BW). What do the DNs represent ?  

The numbers are simply on a comparative scale relative to lighting from the NW 

 

Note how well it displays topography:  

The bowl versus Cranbrook Hill, the dissected glacial deposits in the Hart, sinuous eskers north 

of the Nechako, flat area near the airport (you can see the roads as they are raised on gravel 

above the wet clay lands of beds of glacial lake Prince George); note the general NE-SW trend of 

the small hills on Cranbrook Hill (=direction of glacial advance/retreat), and how clear Tabor 

Lake is compared to the DEM. There is some vertical striping from the TRIM ''mass points'. 

 



3. Some bitmap flooding 

 

a. In the same way that we tried to extract water using a threshold value in the NIR band for 

water in Lab 2, let's do the same here by finding and 'flooding' the image with a rise in water 

level to 600metres elevation. 

 

Tools → algorithm librarian and find THR 

Input is the elevation channel 

Output to viewer-PCT  

In the parameters, add 600 for maximum 

If you need a minimum, enter the lowest elevation for this DEM 

Run and you should see the landscape 'flood' to 600 metres. 

 

Turn off the DEM channel so you can see the flooding over the image landscape (543 composite) 

 

When the glaciers retreated ~12,000 years ago, impounded meltwater formed Glacial Lake 

Prince George which  reached up to ~ 760 metres elevation ..exactly the height of UNBC Agora. 

Rerun THR with a maximum value of 760 – output to viewer-PCT and your pix file. 

Zoom in on UNBC to see where the lakeshore would have been. 

 

b. ARE task – Area under bitmap 

This calculates the area under the bitmap (area flooded in this image) 

Input elevation channel 

Mask = the bitmap you just created 

Output – you get a numeric output 'actual area' and 'projected area'  

 

Q2a: what are the two area values and what do they mean (the help is not helpful),  

hint: they would be the same if it was flat – ArcMap gives the same dual results 

 

c. VLM task 

This calculates the volume under the bitmap – int his case the volume of flood water 

The answer may be in scientific notation, but the 'output parameters' tab also gives the answer. 

 

Q2b. What is the volume of water with the lake at 760m  

(in this image … the lake extended far further beyond the image area) 

 

Note: if you wanted to calculate the unflooded area and volume of land above the lake level, 

you'd simply do the reverse threshold and find all land above 760m 

 

OK, enough of PG, we are off to the Rockies ….. 

-------------------------------------------------------------------------------------------------- 



4. Preparing the Resthaven DEM 

 

Let’s enjoy a more exciting DEM: 

File-> New project 

No need to save the PG ‘project’ unless you want to load this exact setup again 

– then save and give it a name 

 

Open your 2015 Resthaven file from last week (rm2015.pix) and the stretched 654 composite 

 

As this is across the Iron Curtain in Alberta, there is no 'TRIM' DEM data, but I've downloaded 

the federal DEM from 'Toporama' online and clipped it to fit our image area stored in  

L:labs/GEOG357/willmore/rh-dem-utm.pix    (I saved as .pix, but it could have been .tif) 

Open this file in the project (no need to copy it) and we'll transfer it into our image file 

 

File-> utility-> TRANSFER 

source:  the DEM file (it should already be listed if you just opened it) 

destination: your rh2015.pix file 

select all-> add->transfer layers 

Close 

 

Check it is there: switch from maps to files tab 

Expand the rasters list -> the DEM should be the bottom layer / channel 

Rename it properly - right-click -> properties and type its name as the label e.g. DEM 

Note that this time, it's a16 bit layer, like the image bands, but 16S (allowing for possible 

negative values unlike an unsigned channel for band reflections) while the bands are 16U. 

switch tab back to maps from files 

 

Note: all channels must be in the same pix file for analysis and display: every new layer you 

create in the lab becomes a channel in your 2015 .pix file  

 

Viewing your DEM 

 

Remove the original DEM file from your display (the one stored in L:\labs) 

Add the new transferred DEM channel to the display:  layer -> add -> grayscale -> pick the 2015 

file -> DEM channel -> Finish 

 

.. click the mouse on a few locations, and view all values in layers-> histogram  

 

Q3a: what are the minimum and maximum elevation values ?  

 

You could flood this landscape too if you wished using the same method as in A. for PG, but it's 

too beautiful to flood, unlike downtown PG 



5. Shaded Relief  ( REL )  
 

Output Ports: Select Viewer-Grayscale - no need to save this as a channel as it's for viewing 

 

INPUT PARAMS TAB 

Pixel X Size: 30 

Pixel Y Size: 30 

Elevation Step Size: 1   (= the ‘step’ between adjacent integer values) 

Azimuth  Angle of Light Source: 315 

Elevation Angle of Light Source: 45 

 

Select LOG tab and run  

It's a bit scrappy – the federal models from digitised map contours are not as smooth as the BC 

TRIM directly from air photos, but it will do. You can see the difference in the SW corner 

section in BC where it is derived from BC TRIM data. 

 

Q3b: What is a typical shaded relief DN value on a flat slope e.g. lake ? 

 

6. Slope gradient (and ASPECT): SLASP  
   

Input = the DEM channel 

Run and display slope in viewer-PCT, and also output to your  .pix file 

We don't have any need for Aspect, so don't tick any output options for Aspect 

 

query the slope values:  what are typical DNs on the slopes inside the lakes, on mountain tops ?  

(You must highlight the slope layer in the TOC list) 

AARGH!! they are in 32-bit - overkill ! 

We could fix that by 'transferring it into an 8 bit channel… create an empty 8-bit raster layer  

Files tab, right-click on filename -> New -> raster layer -> 8 bit .. add one and close 

 

In Tools-> EASI Modeller, type %x =%y  (and Run)  DO NOT TYPE X and Y !!!! 

Where x is your new empty layer and y is your slope channel.  

This write the 32 bit slope values into an 8 bit file, truncating the decimals. 

 

Note: if you do this in reverse, you wipe out your slope layer with 0 values from the empty layer 

You should now have a slope layer with DNs in integer values – no silly 5 place decimals 

 

If you have problems with this, no worries as we can use the decimal slope layer – it's just 'false 

precision' as the model is not good enough to warrant such detail. 

 



We could use slope to clean up your Bowron water bitmap from Lab 6. (but not today) 

Obviously if slope is not 0 (flat), it can't be water, but more likely shadow on slopes 

In tools-> EASI modelling, we'd write a condition that water bitmap must =0 AND slope = 0 

….  that would remove shaded sloping pixels. 

Equally it could help remove cutblocks from your previous avalanche slope layer, although it's 

tricky as Avalanche slopes generally occur on slopes 25-45 degrees, but the ‘run-out’ section at 

the end is less steep.  

 

7. Incidence: ANG le of Incidence  

 
Remember from lecture notes, we can get around the issue with Aspect that it is circular but still 

retain a layer that indicates different lighting i.e. Incidence 

 

Input is the DEM channel 

Light source: we have the sun's azimuth and elevation angle from the scene metadata which is 

included whenever you download image data from the EarthExplorer website. 

This will be the only  text file (.txt) in the L:\labs\geog3537\willmore folder. 

View it – you don't need any software for a text file and look for these two parameters: 

 

Sun Azimuth =                             and Sun elevation = 

Use the numbers given in the .txt file 

'Distance’ is technically 150 million km (the sun) but 100000 is good enough 

Output to grayscale AND your image pix file 

Run ANG  

What are the resulting DN values ?.. incidence values are always between 0-90 

How are the DNs different to the hillshading ? – quantitatively they are now meaningful  

   

Q4a. What are the minimum and maximum incidence values 

Q4b: what is the incidence value for flat terrain (lakes): why is this obvious in hindsight ?  

(think trigonometry and how the value is created) 

 

 

7. SEENARE (visibility) – (same as Viewshed in ArcMap) 
 

Input location with DEM as input layer; it will produce every pixel visible from that point -  

Try it from this location: 337000, 5914000   and elevation 2150 (metres) 

This creates a bitmap, though we won't use it further. 

 

The last section of the lab uses 'Fly Banff' – like ArcScene or Google Earth to generate 

perspective views. Before 2005, this software was the Cat's Meow or (Doggie's wuff?), but 

everyone is used to GE, though it only uses the visible bands. 

You might be able to see something like the views below taken by MacKenzie M *  of Chown 

Glacier – the southern part of the Resthaven Icefield. 



*We have two Mackenzies, but this one is MacKenzie M. and Mackenzie H has a small k. 

So I'll refer to them as MacK and Mack, or Mack H and MacK M. It's a bit like the Spice Girls who had 

two Melanies, so they were known as Mel B and Mel C - as well as Scary and Sporty :) 

 

 

 

 

MacK seems to be near 338000, 5915000 for view 1, and 337000, 5914000 view 2. 

She can correct me if I'm wrong – I used the slope layer to find flat spots – you can match the 

glaciers in the image with those in the photos (see image area below).  

 

Your goal then for the final mark is to recreate one of these views in 'Fly' as below: 



- or if you have difficulty with these views, select a perspective of your choice that 

captures the essence of the area 

 

 

8. FLY (like an eagle) 

 
It’s like Google Earth, with a better band combination, but lower Landsat res. here 

Run the flight simulator from the Geomatica Banff options .. (eye in the sky)  

 

When it starts pick:  file-> Load DEM + RGB 

in the next window, .. select the DEM channel (navigate to it, select and close) and then select 6-

5-4 in your copy of the 2015 image (select and close) 

 

The defaults fly you too low, and the window is small, so change using edit -> options  

edit-> perspective->position/speed/direction - change vertical position to 5000, angle to 50 

Need more vertical exaggeration: edit-> perspective-> change height magnification to 2  

 

FLY control panel:  

left button allows you to change parameters - you will need to increase 'elevation' from 1 to 3 to 

exaggerate terrain 

second button starts a FLY 

third button displays a vertical view        …  check out options etc.. 

 

Q5: Use the windows (Osmotar) snipping tool to capture your image (same as last week) 

 

 



Questions repeated here: please send by next Wednesday – either as email message with 

image attached, or as .doc  file including the image 

 

PG DEM 

Q1. What is the elevation of      a. Shane Lake         b. Tabor Lake   ?  

Q2a: what are the two area values under the bitmap and what do they mean (help is not helpful),  

Q2b. What is the volume of water with the lake at 760m  

 

Resthaven DEM 

Q3a: What are the minimum and maximum elevation values ? 

Q3b: What is a typical hillshading DN value on a flat slope e.g. lake ? 

 

Q4a. What are the minimum and maximum incidence values 

Q4b. What is the incidence value on a flat slope e.g. lake .. why is this value obvious ? 

        (think trigonometry) 

Q5. Attach your flight image  

 

 

 

9. Classification – Optional or project 

 
One reason to create these DEM channels is to improve classification in mountain areas like BC.  

I'm thinking this lab is already long enough .. it would not take long with unsupervised, but 

likely needs supervised e.g. to create training areas with sunlit and shaded samples for bare rock. 

This would be a possible project option. 

 

Try an unsupervised classification –  

a. using as input only bands 6,5,4 

b. repeat with bands 6,5,4 plus DEM (elevation), slope and Incidence ... 

- does adding DEM channels help ? 

 


